
 

G-clamp version 2.1.1 

User Manual 
Paul H.M. Kullmann and John P. Horn 

 
Department of Neurobiology and Center for the Neural Basis of Cognition 

University of Pittsburgh School of Medicine 
E 1440 Biomedical Science Tower 

Pittsburgh, PA 15261 
http://www.neurobio.pitt.edu

 
 
 

To download this document and the G-clamp program go to: 
(http://hornlab.neurobio.pitt.edu) 

 
 
 
Contact Information: 
 
 
 
 
 
 
 
 

Dr. Paul H.M. Kullmann 
Phone: 412-648-9291 
pkullman@pitt.edu
 
Dr. John P. Horn 
Voice: 412-648-9429 
jph@pitt.edu

 
Grant Support: This document and the G-clamp software that it describes were both 
developed at the University of Pittsburgh with support from National Institutes of 
Health grant RO1 NS21065. 
 
Copyright Information: These materials are freely available for non-commercial 
research and educational purposes.  The authors reserve the copyright and request 
that others using this material acknowledge its origin.  Those wishing to publish any 
of this material or to develop commercial applications must first contact the authors. 
 

G-clamp v1 2003; v1.2 October 1, 2004 
G-clamp v2 February 1, 2007; v2.1 January 25, 2008; v2.1.1 February 15, 2008 

Copyright © 2008 

http://www.neurobio.pitt.edu/
http://hornlab.neurobio.pitt.edu/
mailto:pkullman@pitt.edu
mailto:jph@pitt.edu


 2 

Table of Contents 

1. PROGRAM START ............................................................................................................................... 4 
2. RUNNING AN EXPERIMENT............................................................................................................. 5 

2.1. TRIGGERING/GATING AN EXTERNAL DEVICE.................................................................................... 6 
2.2. EXPERIMENT LOGGING .................................................................................................................... 7 

3. EXITING G-CLAMP V2 ....................................................................................................................... 8 
4. AMPLIFIER MODULES....................................................................................................................... 9 

4.1. AXOCLAMP 2B ................................................................................................................................ 9 
4.2. MODEL 2400 .................................................................................................................................. 10 
4.3. MULTICLAMP 700B ....................................................................................................................... 11 

5. SYNAPTIC CONDUCTANCE EDITOR ........................................................................................... 13 
5.1. CREATING A NEW SYNAPTIC CONDUCTANCE .................................................................................. 13 

5.1.1. alpha-function........................................................................................................................... 14 
5.1.2. double-exponential ................................................................................................................... 14 
5.1.3. voltage-dependent..................................................................................................................... 14 

5.2. EDITING AN EXISTING SYNAPTIC CONDUCTANCE ........................................................................... 15 
5.3. DELETING AN EXISTING SYNAPTIC CONDUCTANCE......................................................................... 15 

6. SEAL TEST........................................................................................................................................... 16 
7. MEMBRANE TEST ............................................................................................................................. 18 

7.1. CALCULATIONS.............................................................................................................................. 19 
8. BRIDGE TEST ..................................................................................................................................... 21 
9. EXPERIMENT MODULES ................................................................................................................ 23 

9.1. VCLAMP ......................................................................................................................................... 23 
9.2. THRESHOLD-GSYN ......................................................................................................................... 29 
9.3. SYNAPTIC GAIN ............................................................................................................................. 32 
9.4. STRIP CHART.................................................................................................................................. 35 

10. EVENT FILES ................................................................................................................................. 36 
10.1. CREATING EVENT FILES.................................................................................................................. 36 

…with Neurosim ..................................................................................................................................... 37 
11. CONDUCTANCES.......................................................................................................................... 38 

11.1. FAST INACTIVATING NA+ CURRENT................................................................................................ 38 
11.2. DELAYED-RECTIFIERK+ CURRENT.................................................................................................. 39 
11.3. M-TYPE K+ CURRENT ..................................................................................................................... 39 
11.4. LEAK CONDUCTANCE ..................................................................................................................... 39 
11.5. TRANSIENT (A-TYPE) K+ CURRENT – DA NEURONS ....................................................................... 39 
11.6. TRANSIENT (A-TYPE) K+ CURRENT – BULLFROG SYMPATHETIC NEURONS..................................... 39 

12. OFFLINE UTILITIES..................................................................................................................... 41 
12.1. G-CLAMP FILEUTILITIES MASTER.VI ............................................................................................. 41 
12.2. G-CLAMP COUNT APS IN GAI-FILE.VI ........................................................................................... 42 
12.3. G-CLAMP RETRIEVE GTH-FILE RESULTS.VI................................................................................... 44 
12.4. G-CLAMP GET MEMBRANE TEST RESULTS.VI ................................................................................ 45 
12.5. G-CLAMP CONVERT STP-TO-GAI.VI ................................................................................................ 47 

13. DATA FILES.................................................................................................................................... 48 



 3

13.1. NAMES ........................................................................................................................................... 48 
13.2. CONTENT ....................................................................................................................................... 48 

12.2.1 Vclamp - *.IVB..................................................................................................................... 48 
12.2.2 Gsyn Threshold - *.GTH...................................................................................................... 49 
12.2.3 Synaptic Gain - *.GAI.......................................................................................................... 49 
12.2.4 Strip Chart - *.STP .............................................................................................................. 49 

APPENDIX A – G-CLAMP INSTALLATION ........................................................................................... 51 
HARDWARE .................................................................................................................................................. 51 

Connecting embedded controller and host computer.............................................................................. 51 
Connecting recording amplifier and break-out box (BNC-2090) ........................................................... 51 

SOFTWARE ................................................................................................................................................... 52 
TROUBLE-SHOOTING.................................................................................................................................... 54 

APPENDIX B – CUSTOMIZING G-CLAMP............................................................................................. 56 
GAIN V AND GAIN I CONTROLS .................................................................................................................... 56 

Customizing Gain values ........................................................................................................................ 56 
Setting the default Gain values ............................................................................................................... 58 

 



 4 

1. Program Start 
 

- Start the embedded controller 
- Start LabVIEW 8 on the host computer and open the project G-clamp.lvproj 
- Open G-clamp v2 – Host.vi under My Computer\Host 

 

 
 

 
- Once start-up of the embedded controller is complete, press the Run button to start 

G-clamp v2 – Host.vi. The VI will go through an initialization process that includes 
starting G-clamp components on the embedded controller and establishing a 
communication link between G-clamp software running on the host computer and 
on the embedded controller. The final initialization step is the loading of an 
amplifier module (see section Amplifier Modules). 



 5

 
 

- Set your data directory either by typing a path into the DataDirectory control on 
the General page or by using the folder button to the right of the control to open a 
file dialog box: Navigate to the designated data directory and finalize your selection 
by pressing Current Folder in the dialog box. 

- Open up to three experiment modules by selecting them from the list under the 
menu item ExpModules. Each experiment module will be loaded into a sub-panel, 
starting on the page Exp. Module 1 and continuing with pages Exp. Module 2 and 
Exp. Module 3. If you try to load more than three modules, a dialog will appear 
asking you to cancel loading the fourth module or to close one of the already open 
modules1. 

 
 

2. Running an experiment 
- Set up your experiment with the corresponding experiment module (for details see 

the specific experiment module section under Experiment Modules). 
- If you are using an additional amplification stage to boost the output of the 

recording amplifier so that it better employs the full range of the data acquisition 
board (typically ±10 V), set the Gain V and Gain I controls in the Post-amplifier 
amplification box on the General page.2 If you don’t have this amplification stage 
both Post-amplifier controls should be set to 1. 

- Make sure that any settings in the amplifier module section that have to be set by 
the user (see section Amplifier Modules for details) correspond to the real settings 
at your amplifier. 

- Check the control Virtual Conductances on the General page for the status of the 
conductances: green – enabled, red – disabled and the strength of the conductance 

                                                 
1 Closing a module sometimes results in a LabVIEW error message. This error is non-fatal and can be 
ignored: Select ‘Continue’ in the error dialog to proceed with the G-clamp session. 
2 Instructions on how to customize the Post-amplifier controls are given in Appendix B. 
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(in nS)3. (These conductances can be used with all experiment modules except the 
Strip Chart module.) 

- Check the status of the control Save Data: green – enabled, red – disabled. (The 
Strip Chart module ignores this control and always saves data to file) 

- Start the experiment with the Start button on the front panel of the corresponding 
experiment module. 

- If you want to abort the experiment after it was started, use the Abort Exp. button 
in the lower right section of the G-clamp v2 – Host.vi front panel. (This works only 
for experiments with the modules Vclamp and Threshold-gsyn. Synaptic Gain 
experiments can not be aborted and Strip Chart experiments are terminated with the 
Enough data button in this module’s front panel.) 

- Check the RT Loop Info indicator: After each data transmission it indicates 
performance of the dynamic clamp feedback loop by showing mean cycle length 
and its standard deviation as well as maximum jitter. A mean value larger than the 
set value indicates consistent failure to perform at the requested rate while a correct 
mean value but maximum jitter larger than the ½ mean indicates an occasional 
failure which did not affect overall performance. (The Strip Chart module uses a 
data acquisition mode unrelated to the dynamic clamp feedback loop and therefore 
does not evaluate loop performance.) 

 

2.1. Triggering/Gating an external device 
For recording amplifiers with only one command input that is interpreted as either voltage 
command or current command according to the recording mode (Model 2400 and 
MultiClamp 700B) the second of the (typically) two digital-to-analog output channels of 
the data acquisition board can be used to trigger or gate an external device.4  
 
Triggering/gating an external device can be used with the experiment modules Vclamp, 
Threshold-gsyn and Synaptic Gain, but is not available with the Strip Chart module. 
 
When either the Model 2400 or the MultiClamp 700B amplifier is selected, the button Ext. 
Device becomes available. The default setting for this button is ‘Off’ as indicated by its red 
color. Enabling this feature changes its color to green and changes the status of the control 
Parameters for triggering/gating external device on the General page from disabled and 
grayed out to enabled. 

                                                 
3 The kinetics of these conductances are hard-wired into the software and can not be changed while running 
G-clamp v2. Instructions for modifying or adding a conductance are not yet available for G-clamp v2. 
However, consulting the “Programmer’s Guide” for G-clamp v1.2 
(http://hornlab.neurobio.pitt.edu/downloads.htm) should give you an idea about how-to. 
4 This feature is not available when using the AxoClamp 2 B amplifier as this amplifier uses either one of the 
two digital-to-analog output channels depending on the recording mode. 

http://hornlab.neurobio.pitt.edu/downloads.htm
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Triggering an external device requires two parameters: 

- when to give the trigger signal, and 
- the amplitude of the trigger signal. 

 
Gating an external device requires an additional third parameter: 

- the duration of the gating signal. 
 
The timing of trigger/gate signals is specified in a pre-determined event-file (see section 
10). As most trigger and gate inputs of external devices follow TTL logic, the default 
amplitude of the trigger or gate signal is 5 V. The default duration for an event is 1 ms after 
which the output of the digital-to-analog channel returns to 0 V. Note that for repetitive 
trigger and gate signals the duration of the signal has to be shorter than the interval between 
two consecutive signals. If the interval between two signals is equal to the duration (or 
longer) the two events will effectively fuse into one event. For example, if two trigger 
signals are supposed to occur after 500 and 600 ms, setting the duration to 100 ms will 
result in one event starting at 500 ms and lasting 200 ms. 
 

2.2. Experiment Logging 
G-clamp v2 keeps a running record of most experimental settings together with time 
stamps when an experiment is started. User comments (e.g. about drug applications) can be 
added at any time. 
This record is maintained in computer memory until one of two conditions is met: 

- a change in the data directory or 
- exiting G-clamp 
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These two conditions trigger writing the experiment record to a text file in the data 
directory used last (and the start of a new record if a change in data directory occurred). 
Part or all of the current record can also be marked and with copy/paste transferred to other 
applications. 
 
 

3. Exiting G-clamp v2 
The Exit button on the front panel of G-clamp v2 – Host.vi stops G-clamp v2 – Host.vi and 
the G-clamp software running on the embedded controller. It also saves the current 
experiment log as well as information about the amplifier module and the data directory to 
the configuration file for use as start-up parameters the next time G-clamp v2 is started. 
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4. Amplifier Modules 
Amplifier modules contain amplifier-specific controls required to communicate the 
recording mode (current clamp, voltage clamp) to the G-clamp software. The last module 
used is loaded at program start. To change the amplifier module, select another amplifier 
on the “General” page of the experiment section. 
 
Currently modules for three amplifiers are available: 

- AxoClamp 2B from Molecular Devices (formerly Axon Instruments) with the x 0.1 
LU gain headstage 

- Model 2400 from A-M Systems, Inc with a headstage that has the 100 MΩ/10 GΩ 
feedback resistor combination 

- MultiClamp 700B from Molecular Devices (formerly Axon Instruments) 
If you have a different amplifier or one of these amplifiers with a different headstage, 
consult the manual with the set-up instructions. 
 
 

4.1. AxoClamp 2B 
The AxoClamp 2B amplifier has two separate inputs for external current and voltage 
commands. For the G-clamp program to use the right command input, the user has to set 
the recording mode in the amplifier module section. Note that only BRIDGE (current 
clamp) and (cont.) SEVC (voltage clamp) are available. 
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4.2. Model 2400 
The Model 2400 amplifier telegraphs several of its settings to the computer. Actively used 
by the G-clamp program are the MODE and GAIN settings, while the FILTER and 
Cmembrane settings are only of informative nature to the user. The remaining two 
controls, PROBE GAIN and EXTERNAL CLAMP SIGNAL, are NOT telegraphed and 
have to be set by the user for correct scaling of the amplifier output and the amplifier input 
command. 

 
 
The status of the telegraphed amplifier settings are updated automatically each time before 
an experiment is started and an update can also be initiated with the button Amplifier 
Settings - Update to the right. 
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4.3. MultiClamp 700B 
The MultiClamp 700B amplifier is fully computer-controlled. The USB connection 
between the amplifier and the computer communicates all settings and commands from the 
controlling software (MultiClamp Commander) to the amplifier. Telegraphing is therefore 
done not via physical outputs from the amplifier but by accessing the status of the 
MultiClamp Commander software5. For this reason, G-clamp and MultiClamp Commander 
have to run on the same host computer and the MultiClamp Commander has to be open 
already when the MultiClamp 700B amplifier module is started. 
 
G-clamp works only with channel 1 of the MultiClamp 700B! 
 
The MultiClamp Commander software does NOT 
provide access to any settings configured via the 
Options dialog. Therefore the settings for Feedback 
Resistor and External Command Sensitivity and 
changes in any of these settings have to be repeated on 
the Gains page of the MultiClamp 700B amplifier 
module! 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

                                                 
5 This is done by calling functions contained in AxMultiClampMsg.dll which is part of the MultiClamp 
Commander software installation. 



 12 

G-clamp requires that the amplifier outputs are set to specific conditions depending on the 
recording mode: 
- V-clamp:  Primary Output – Membrane Current 
   Secondary Output – Membrane Potential 
- I-clamp/I = 0: Primary Output – Membrane Potential 
   Secondary Output – Membrane Current 
Any other setting will result in an error message by the amplifier module. 
 
Taking the Feedback Resistor settings into account, the MultiClamp 700B amplifier 
module reads out the recording Mode and the Gain settings of primary and secondary 
output to determine the scaling factors of the analog input signals (VM and IM). This is done 
automatically each time an experiment is started or when the button Amplifier Settings - 
Update is pressed by the user. The amplifier module also reads out and displays the 
settings of the Lowpass Filter frequencies of primary and secondary output as well as the 
AC filter frequency operating on the primary output and the lowpass filter frequency 
operating on the Scope output. (Bypass or DC settings in the MultiClamp Commander are 
represented in the amplifier module as 100 kHz (Lowpass Filter) and 0 Hz (AC and 
Scope)) 
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5. Synaptic Conductance Editor 
The Synaptic Conductance Editor allows the user to define the kinetics of a synaptic 
conductance gsyn for use with the experiment modules Threshold-gsyn and Synaptic Gain. 
Once a synaptic conductance has been defined its kinetic parameters are preserved in a 
configuration file and therefore defined synaptic conductances are available from the 
beginning whenever G-clamp v2 is started. The Synaptic Conductance Editor also allows 
modification (editing) of an existing synaptic conductance and its removal (deleting) from 
the configuration file. 
The Editor is started from the G-clamp v2 – Host.vi menu: Edit > Synaptic 
Conductances. At start, it reads the configuration file and populates the list of existing 
synaptic conductances with their names. 
The Cancel button stops the Synaptic Conductance Editor and exits it without any changes 
to the configuration file. 
A new synaptic conductance or modifications to an existing synaptic conductance become 
available for use immediately after exiting the Synaptic Conductance Editor, i.e. no G-
clamp restart is required. 

 
 
Next the user has to select an action: 

- Create new 
- Edit existing 
- Delete existing 

 

5.1. Creating a new synaptic conductance 
First the user has to select one of three possible kinetic models for the new synaptic 
conductance: 

- alpha-function 
- double-exponential 
- voltage-dependent 
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Once a kinetic model has been selected, a model-specific field for setting the model-
specific parameters becomes visible. Any change of a parameter triggers an update of the 
conductance waveform graph which shows the template for the synaptic event that G-
clamp will use whenever the Threshold-gsyn or Synaptic Gain modules execute. This 
template has a finite length which the user has to specify with the Duration parameter. 

5.1.1. alpha-function 
gsyn(t) = k x t x exp(-t/tau) 

 
with k = e/tau and e the base of the natural logarithm. 

5.1.2. double-exponential 
gsyn(t) = k x exp(-t/taurise) – exp(-t/taufall) 

 
with k a dimensionless factor that scales the peak to unitary (1 nS) conductance. 

5.1.3. voltage-dependent 
This kinetic model mimics a NMDA-receptor conductance and its voltage-dependent block 
by extracellular Mg2+. 
 
gsyn(Vm,t) = [k x exp(-t/taurise) – exp(-t/taufall)] / [1 + eta x [Mg2+] x exp(-1 x gamma x Vm)] 
 
with k a dimensionless factor that scales the peak to unitary (1 nS) conductance. 
This model as well as the default values of its parameters (taurise = 0.67 ms; taufall = 80 ms; 
eta = 0.33 / mM; gamma = 0.06 / mV) are from Zador, Koch & Brown6. 
The voltage-dependence of this conductance can be studied by changing the parameter 
“Vm” and by toggling the waveform display between conductance (g) and current (I). I is 
calculated assuming a reversal potential of 0 mV. 
                                                 
6 Zador A, Koch C & Brown TH (1990) Biophysical model of a Hebbian synapse. PNAS 87:6718-6722 
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5.2. Editing an existing synaptic conductance 
Selecting the conductance to be edited in the list of existing synaptic conductances brings 
up the parameter field for the conductance. For details on the different kinetic models see 
the preceding section, ‘Creating a new synaptic conductance’. 

 
 

5.3. Deleting an existing synaptic conductance 
Select the conductance to be deleted in the list of existing synaptic conductances. 
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6. Seal Test 
This function, which is similar to the seal test function in PClamp, serves to monitor seal 
formation while patching a cell in voltage clamp. A unipolar, periodic voltage7 step is 
given and the current response is monitored: As the patch pipette approaches the cell 
membrane and forms a seal, the initially large current response becomes smaller and 
smaller. 
The trace shown reflects the average of the last 10 current responses and the values shown 
for seal resistance (Rseal) and holding current (Ih) are based on this average. 
Ih is the mean holding current during the last 25% of the pre-voltage-step period and Rseal 
is then calculated according to Ohm’s Law from the difference between Ih and the last 25% 
of the current response during the voltage-step. 
 

 
 

                                                 
7 If the recording amplifier (and the corresponding amplifier module of the G-clamp software) is in current 
clamp mode, a current command will be given. 
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7. Membrane Test 
This function, which is similar to the membrane test function in PClamp, uses the current 
response to a unipolar voltage8 step to calculate several parameters after whole-cell 
configuration has been achieved. 
 

 
 
The fit limits are relative to the difference between peak response and holding current for 
the upper limit and relative to the difference between peak response and steady-state 
current for the lower limit. 
 
The trace displayed and all calculations are based on the average of the last 10 responses. 
 
The button Add to Log creates an entry with the current values in the experiment protocol. 

                                                 
8 If the recording amplifier (and the corresponding amplifier module of the G-clamp software) is in current 
clamp mode, a current command will be given. 
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7.1. Calculations 

Vhold
ΔV = pulse
amplitude

Iss

Ipeak

Ihold

Iss

 
 

- Holding current (Ih) is determined from the last 25% of the pre-voltage-step period. 
- Steady-state current (Iss) is determined from the last 25% of the voltage-step 

period. 
- The transient portion of the current response is fit with a single exponential which 

gives the time constant (tau). 
The area (charge Q) under the current transient can be used to calculate access resistance 
(Ra) and membrane resistance (Rm). 
 

ΔI = ΔV/(Ra+Rm)
Ihold (at Vhold)

Iss

Q1 = CV

Q2
Q3

Tau

 
 

The total charge (Qt) under the transient is the sum of the charge (Q1) in the transient 
above the steady state response plus the correction factor (Q2): Qt = Q1 + Q2 

- Q1 is found by integrating the charge above Iss. 
- Q2 is calculated as ΔI x tau = (Iss – Ih) x tau. 

The small error charge (Q3) introduced with the calculation of Q2 is ignored. 
After Qt has been derived, Cm can be calculated: 

Cm = Qt / ΔVm  (1) 
where ΔVm is the amplitude of the voltage step. 
In the steady-state, the relation between ΔVm and ΔV is: 

ΔVm = ΔV x Rm/Rt = ΔV x Rm/(Ra + Rm)  (2) 
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where Rt, Rm and Ra are the total, membrane and access resistances, respectively. 
Substituting for ΔVm from (2) into (1) derives: 

Cm = Qt x Rt / ΔV x Rm (3) 
Substituting (3) for Cm in definition of the time constant = Ra x Cm: 

tau = Qt x Ra / ΔV 
yields: 

Ra = tau x ΔV / Qt  (4) 
which provides access resistance directly as a function of measured variables. The total 
resistance is calculated from the steady-state response: 

Rt = ΔV / ΔI = Ra + Rm (5) 
from which one obtains: 

Rm = Rt – Ra  (6) 
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8. Bridge Test 
This function serves to monitor and adjust the settings of the bridge circuitry while 
recording in current clamp from a cell. A unipolar, periodic current9 step is given and the 
voltage response is monitored. Because the much smaller capacitance of the pipette charges 
much faster than the whole-cell capacitance, the voltage response has two phases: The 
initial, almost instantaneous change reflects charging of the pipette capacitance10 and its 
amplitude reflects the size of the access resistance. By setting the bridge so that the slower 
response of the whole-cell capacitance seems to rise exactly from the pre-current-pulse 
level the voltage drop across the access resistance is eliminated. 
The trace shown reflects the average of the last 10 voltage responses. 
 

 
 

                                                 
9 If the recording amplifier (and the corresponding amplifier module of the G-clamp software) is in voltage 
clamp mode, a voltage command will be given. 
10 Detection of this change is facilitated by increasing the cut-off frequency of the low-pass filter operating on 
the amplifier’s voltage output and by turning up the capacitance neutralization of the amplifier to speed-up 
the charging process. 
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9. Experiment Modules 
 

9.1. Vclamp 
The name of this module is somewhat misleading; seemingly implying that it is intended 
only for voltage clamp recordings. In fact, the purpose of this module is to generate several 
types of command waveforms for the amplifier irrespective of whether the amplifier is in 
voltage clamp or (dynamic) current clamp mode. 
Currently three types of command waveform are available: 

- square pulse 
- ramp 
- zap (a frequency-modulated sine wave) 

These commands can be combined sequentially and command amplitudes can be made to 
increment or decrement from one iteration to the next. 
 
(Almost) all experiment parameters are defined in a script-like protocol. Protocols are 
stored in an array, of which only one element (protocol) is visible at any time and this 
visible protocol is the one that will be executed upon pressing Start. 
To scroll through the array of protocols use the horizontal slider at the bottom of the 
Scripts window. 
When scrolling through the array of protocols11 the waveform display shows exactly what 
command(s) will be given to the amplifier. 
Similarly, editing a protocol in the Scripts window triggers continuous updates of the 
waveform display. If your waveform does not look like what you expect you probably have 
a syntax error in your protocol. Note that no error-checking is implemented and therefore 
execution of a script containing syntax errors could crash G-clamp! 
 
Before explaining some example protocols the general rules of the protocol syntax shall be 
described: 

- All expressions have to be typed in lower case 
- In (most) commands consisting of an expression and a numerical value expression 

and numerical value have to be separated by exactly one space 
- Each command consists of a separate line 
- Comments can be added to a script by placing the % symbol at the beginning of 

each comment line 
- Required commands for a script are (in the following xy denotes a numerical value 

and [text in square brackets gives additional information]): 
o samplerate xy  [sample rate in Hz] 
o pause xy  [time in ms from end of one episode to start of next] 
o for xy [indicates start of a recording episode with the 

duration of the recording episode determined by the 

                                                 
11 Scrolling through the array of protocols while grabbing the slider with the cursor does not always trigger a 
waveform update. In this case move the cursor into the script field and click the left mouse button once. 
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sum of all ‘wait’ commands from here to the ‘end’ 
command; xy has to be at least 1] 

o end   [indicates end of the recording episode] 
o wait xy [time in ms before a change in the amplifier command 

is given; at least one ‘wait’ command has to be within 
the ‘for xy’ – ‘end’ sequence to set the duration of the 
recording episode] 

- A ‘wait’ command can not be followed by another ‘wait’ command. 
- Commands that change the amplifier command are (in the following xy denotes the 

amplitude of the command in mV for a voltage clamp command and in pA for a 
current clamp command and [text in square brackets gives additional information]): 

o const xy [sets the amplifier command to a new value 
which remains in effect for the duration of the 
following ‘wait’ command] 

o ramp xy [initiates a linear change in the amplifier 
command starting at the previous amplifier 
command level; the speed of the change is 
determined by the following ‘wait’ command] 

o zap xy fstart xy fstop xy [initiates a frequency-modulated sine wave (of 
amplitude xy) command to the amplifier: the 
start frequency is set with the numerical value 
after ‘fstart’ (inHz) and the end frequency 
with the numerical value after ‘fstop’ (in 
Hz)12; the speed of the frequency-modulation 
is determined by the following ‘wait’ 
command] 

All of these commands operate relative to the holding potential (voltage clamp) or 
DC current command (current clamp) dialed in on the recording amplifier. 

- The ‘const’ and ‘ramp’ commands can be followed by either ‘decrement xy’ or 
‘increment xy’ (with xy denoting the change in the amplifier command) which 
successively changes the effective value of the preceding ‘const’ or ‘ramp’ 
command from episode to episode. The change becomes effective with the second 
episode, i.e. in the first episode the effective amplifier command corresponds to the 
value of ‘const’ or ‘ramp’. 

 
To add a new script scroll to the end of the protocol array. The last element is grayed-out, 
indicating that it is not an active script. It is activated by starting to edit it. 
 
To make any changes to the scripts permanent you have to exit the module by using the 
Close Module button. Any changes made to scripts are lost if you exit G-clamp v2 with the 
Vclamp module still open. 
 

                                                 
12 Setting ‘fstart’ and ‘fstop’ to the same value xy yields an unmodulated sine wave of frequency xy. 
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This script generates a square pulse of 10 mV/pA with a delay of 50 ms by first giving the 
amplifier command ‘const 10’. This command level is maintained for 50 ms before another 
amplifier command (‘const -10’) returns the command level to zero. The recording episode 
ends after another 50 ms. This pattern is repeated 50 times (‘for 50’) with 150 ms breaks in 
between episodes (‘pause 150’). 
If the last amplifier command does not return the command level back to zero, that 
level will be maintained during the pause until the start of the next episode! 
 
 

 
 
This script gives a series of negative square pulses of increasing amplitude. The first pulse 
is -10 mV/pA (‘const -10’). With ‘increment -10’ this value becomes -20 mV/pA for the 
second episode (-10 + -10 = -20), -30 mV/pA for the third epsisode (-20 + -10 = -30) and 
so on. With the last, seventh episode (‘for 7’) the command level reaches -70 mV/pA. 
Note: ‘increment -10’ is equivalent to ‘decrement 10’ 
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This script demonstrates the combination of a pre-pulse and a variable test pulse. With 
‘const 50’ the pre-pulse is initiated and maintained for 400 ms (‘wait 400’). By being 
relative to the preceding command level ‘const 20’ next changes the command level to 70 
mV/pA (50 + 20 = 70) in the first episode. With ‘increment 20’ the change relative to the 
pre-pulse becomes 40 mV/pA in the second episode, 60 mV/pA in the third episode and so 
on. 
 
 

 
 
This script demonstrates the use of the ‘ramp’ command. The numerical value of the ‘ramp 
-80’ command sets its amplitude (-80 mV/pA) with the start value defined by the preceding 
amplifier command level: In this case set to 40 mV/pA with the preceding ‘const 40’. The 
speed of the ramp is -20 /s (-80 / 4000 ms) as set by the following ‘wait 4000’ command. 
At the end of the ramp the amplifier command level returns automatically to a value 
corresponding to the midpoint of the ramp. Note that although in this example the ramp 
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returns to 0 mV/pA as it starts at 40 mV/pA and ends at -40 mV/pA, a ‘const 0’ command 
is required in the script between the ‘wait 4000’ specifying the ramp duration and the ‘wait 
800’ specifying the post-ramp time before the recording episode ends. If the midpoint of a 
ramp differs from 0 mV/pA the value for the following command then should be relative to 
the ramp midpoint. 
 
 

 
 
This script demonstrates the ‘zap’ command13. It generates a sine wave. The frequency of 
the sine wave increases at a constant rate from a start value to an end value. In this example 
(‘zap 15 fstart 0 fstop 5’) the sine wave starts at 0 Hz and ends at 5 Hz. The speed of the 
modulation is determined by the following ‘wait’ command, therefore in this case (5 Hz – 0 
Hz) / 10000 ms = 0.5 Hz / s. Note that after the ‘zap’ command the value of the next 
‘const’ command is absolute and not relative to the level achieved at the end of the sine 
wave!
 
 
Data files generated by the Vclamp module are of type ‘.ivb’. 
 
 

                                                

Simulate? allows observation of the behavior of an implemented (non-
synaptic) conductance under voltage clamp conditions. The recording 
amplifier is operated in voltage clamp mode and a script is used to run 
a voltage clamp protocol (e.g. the protocol to measure IA steady state 
inactivation described above). The script – together with the holding 
potential dialed-in at the amplifier – determine the Vm reading. Based 

on the measured Vm G-clamp calculates the current that would flow through the 
conductance at any time. Instead of using this value as a command to the amplifier the 
value is only displayed to the user (as the Im trace) and, optionally, saved to file. 

 
13 It seems like only sine waves symmetrical around 0 mV/pA work: Using a preceding ‘const xx’ command 
to let the sine wave oscillate around xx mV/pA does not work! 
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Leak Subtraction is only for voltage clamp recordings to correct for a cell’s passive 
membrane current, i.e. leak current. G-clamp uses P/N subtraction in which a series of 
scaled-down versions of the command waveform are generated, and the responses to the 
scaled-down versions are accumulated and subtracted from the command response. Scaled-
down versions are used to prevent active currents from being activated. The number of 

nds is the “N” referred to in P/N. The command waveform (pulse 
P) is scaled down by a factor of 1/N, and this is applied N times 
to the cell. Since leak current has a linear response, the 
accumulated responses of the subsweeps approximate the leak 
current component of the response to the actual command 
waveform. 

these scaled-down comma

                                                

For added flexibility in preventing the occurrence of active 
currents, the polarity of the P/N waveform can be reversed by 
making N in Protocol (P/N) a negative value and/or by eliciting 
the scaled-down versions from a different holding potential as 
dialed in at the recording amplifier by shifting it with Vhold 
(mV). 

To speed-up the process of running the leak subtraction, the scaled-down versions of the 
command waveform are executed without the delay between episodes that is defined with 
the ’pause’ command in the script. Instead brief breaks before (Pre-Pulse) and after (Post-
Pulse) each subsweep can be added with the Settling Times (ms) controls. 
 
With Leak Subtraction (and Save Data) enabled G-clamp generates two data files: One 
file contains the raw data and the other one contains the leak-subtracted data. Both files are 
of type ‘.ivb’ and have a name consisting of the usual recording time stamp (ddhhmmss14) 
plus ‘_leak_and_test-pulses’ for file with the raw data and ‘_leak_subtracted’ for the file 
with the corrected data. 
 
 

 
14 d – day, h – hour, m – minute; s – second 
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9.2. Threshold-gsyn 
This module determines the strength of a virtual synaptic conductance required to bring the 
neuron under observation to action potential threshold. It does this in an iterative process in 
which the strength of the virtual synapse is adjusted depending on whether the previous 
trial elicited an action potential or not. An initial starting value (g (nS)) reflecting an upper 
limit has to be set by the user. The procedure operates by setting the strength of the virtual 
synapse to the arithmetic mean of the upper and a lower limit which is initially zero. If this 
setting elicits an action potential the current setting becomes the new upper limit, if it fails 
to elicit an action potential the current setting becomes the new lower limit. Typically, 
within 10 iterations the procedure zeroes in on threshold-gsyn. 
The peak of an action potential has to exceed 0 mV in order to be identified as an action 
potential. 
The type of synapse is determined by the selection made from the Kinetic control and by 
the setting for its reversal potential (Erev (mV)). The timing of the synaptic event is 
specified with the control Event File. To select an event file click on the folder symbol to 
the right of the control and select an event file from the file dialog15. 
The Variable? control has to be enabled (green) to allow for the iterative adjustment of 
synaptic strength. Disabling Variable? (red) keeps the strength of a synapse constant and is 
an easy way to test the behavior of a cell repeatedly to the same synaptic input. 
 

 
 
Duration (s) determines the length of one recording episode, Pause (s) the length of the 
break from then end of one episode to the start of the next and Iterations determines the 
number of episodes. 
 
 

                                                 
15 An event file can be called more than once, e.g. to implement simultaneous events or implement different 
types of conductances activated by the events (e.g. AMPA- and NMDA-type conductances). 
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The Traces page shows the most recently acquired trace while the experiment is still in 
progress and all acquired traces of the selected channel after the experiment ends. 
 

 
 
The History page plots the threshold-gsyn values of consecutive experiments vs. real time. 
This chart has a buffer which can hold up to 200 pairs of threshold-gsyn and time values 
after which the oldest pair becomes replaced with the newest pair with each new 
experiment. The buffer can also be emptied with Clear Chart. 
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By selecting more than one event file, the behavior of a cell to a combination of several 
virtual synaptic inputs can be tested. For example, the effect of the after-hyperpolarization 
following one or more action potentials on threshold-gsyn can be tested by using one event 
file and giving these synapses supra-threshold strength in combination with another event 
file which contains the synapse to be tested. 
When using more than one event file, the Variable? property can only be assigned to one 
event file. The first occurrence of a synaptic event in the event file for which Variable? has 
been enabled sets the start time for the action-potential-identifying algorithm and allows 
action potentials generated earlier by synaptic events in other event files to be ignored. 
 

 
 

 
 
Data files generated by the Threshold-gsyn module are of type ‘.gth’. 
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9.3. Synaptic Gain 
This module uses event files to stimulate a neuron with patterns of virtual synaptic activity 
and it determines the number of action potentials generated by these synaptic events. 
 

 
 
The controls in the Parameters section have identical function as the corresponding 
controls in the Threshold-gsyn module. In this module synaptic strength(s) is fixed, 
therefore g (nS) specifies gsyn. 
Duration (s) determines the length of the recording episode. 
 

 
 
Because displaying the potentially huge amount of data acquired with a Synaptic Gain 
experiment can cause memory problems on the host computer the waveform graph on the 
Trace page shows no more than 1 million data points. Every trace (or zoomed-in section of 
a trace) larger than 1 million data points will be decimated until it is less than 1 million. 
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With gon delay (s) and goff (s) an initial and a final part of the recording episode can be 
excluded from virtual conductance (synaptic and/or non-synaptic) activity and/or the DC-
current command (see below). 
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DC-current (pA) can be used to add a DC current command to the recording episode. 
 

 
 
Data files generated by the Synaptic Gain module are of type ‘.gai’. 
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9.4. Strip Chart 
The Strip Chart module is an acquisition-only module that records voltage and current 
traces for as long as the user wishes. It was originally developed to record long, 
uninterrupted sequences of spontaneous pacemaking activity of midbrain DA neurons. 
Because no computations are performed and no commands are given to the amplifier, 
recorded data can be sent every second from the embedded controller to the host computer 
and displayed to the user without interference with the ongoing data acquisition. 
The only parameter that can be set by the user is sample rate (Hz). 
After initiating a data acquisition with the Start button the Start and Close Module 
buttons become disabled and grayed out. 
Data are acquired, transferred to and displayed on the host computer in 1-second packets. 
This module always saves the acquired data into a file (with the file name extension ‘STP’) 
irrespective of the status of the Save Data button in the lower right section of the G-clamp 
user interface. The file is created when the first 1-second packet arrives and its name is 
built from the recording time of this first packet. New data are appended to this file as they 
arrive on the host computer. STP-files can be converted to a GAI-file with the offline 
utility Convert stp-to-gai.vi. 
 

 
 
The Freeze button stops updating of the waveform graph thus allowing closer inspection of 
the trace currently on display. This has no effect on the on-going transfer and saving of 
data. 
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10. Event files 
Event files are new in G-clamp v2 and replace the template files used in G-clamp v1. Event 
files are text files with the file extension EVT containing a single column of numbers 
standing for the timing (in ms) of virtual synaptic events. The type of virtual synapse, i.e. 
its kinetic, is determined by the user with the Kinetic control of the experiment modules 
Threshold-gsyn and Synaptic Gain. Thus a single event file can be used for different types 
of virtual synapses. 
In addition, starting with G-clamp v2.1 event files can be used to specify the timing of 
trigger or gate signals for an external device (see section 2.1). 
 
Note that the length of a recording episode is user-specified in both experiment modules, 
Threshold-gsyn and Synaptic Gain. Therefore virtual synaptic events listed in an event file 
to occur at times after the end of the recording episode are ignored. 
 
The constraints for event files are slightly different for G-clamp v2 and later versions. 
 
Gclamp v2: 

- The numbers specifying the time of events have to be sorted in ascending, 
sequential order, i.e. in the order in which the events are supposed to occur. 

- If an event file contains two identical time values (two synaptic events occurring at 
the same time) only one event will start at the specified time and the second one 
will start in the next iteration of the dynamic clamp loop. The delay between the 
two events therefore will depend on the user-specified sampling rate. To implement 
true simultaneous events place the time values for each event in a separate event file 
and execute the event files together.  

 
G-clamp v2.0.1 and later: 

- No ordering of event times required. 
- Event files can contain a time value multiple times, representing simultaneous 

events. All events having the same time will start at that time. (If the event file is 
used to trigger/gate an external device, a time value repeated multiple times in the 
event file will result in only one trigger/gate signal generated at that time.) 

 
Keep in mind the relation between user-specified sample rate and the temporal precision 
used when creating the event file. For example, in an event file with a precision of 50 μs 
two events listed to occur at 100.95 and 101.00 ms will start at these times if sampling rate 
is set to 20 kHz (or a multiple of 20 kHz). However, if the sampling rate is only 10 kHz 
(temporal precision of 100 μs) 100.95 will be rounded up to 101.0. The first of these two 
events will therefore start at 101.0 ms and the second event – as described in the preceding 
paragraph – will start at 101.1 ms. 
 

10.1. Creating event files 
Any text editor can be used to create an event file. File requirements are: 

- The file has to be saved as an ASCII text file. 
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- The file name extension has to be EVT. 
- The file contains only numbers (event times) arranged in a single column (G-clamp 

v2: in ascending order). 
- Time unit is milliseconds (ms). 
- No empty lines (or formatting codes) after the last number. 

 

…with Neurosim 
To create an event file with Neurosim follow the instructions in the Neurosim manual for 
creating a template file of virtual synaptic plasticity. For each synapse (e.g. primary 
synapse, n secondary synapses) Neurosim creates a text file of type DAT which contains 
the event times for that synapse. To use these files as event files in G-clamp v2, the DAT 
files have to be re-formatted and re-named: 

1. Convert the line-arrangement of event times in the DAT file to a column-
arrangement by opening the DAT file with Microsoft Excel. 

2. Use the ‘Increase Decimal’ and/or ‘Decrease Decimal’ function on the column to 
set all event times to the same number of digits after the decimal point, i.e. sub-
millisecond resolution. 

3. Use ‘Save As…’ to save the spreadsheet as a tab-delimited text file to the G-clamp 
event file folder (G-clamp\Event Files). 

4. Open the file with Notepad. Scroll down to the end of the file and delete any empty 
lines after the last event time. Save the file. 

5. Change the file name extension to DAT (if you haven’t done so in step 3. already 
rename the file so that it has a meaningful name). 

If you want to combine the events from several DAT files into one EVT file: 
G-clamp v2: Open all DAT files with Microsoft Excel and use copy-paste to copy all time 
values (without 0’s) into a single column of one spreadsheet. Use the ‘Sort Ascending’ 
function on the column before proceeding with step 2. above. 
G-clamp v2.0.1: Open all DAT files with Microsoft Excel and use copy-paste to copy all 
time values (without 0’s) into a single column of one spreadsheet. Proceed with step 2. 
above. 
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11. Conductances 
G-clamp v2 and v2.0.1 have 6 virtual conductances implemented: 
 

- a fast Na+-conductance (Erev +60 mV) 
- a delayed rectifier K+-conductance (Erev -90 mV) 
- a muscarinic (M-type) K+-conductance (Erev -90 mV) 
- a linear leak conductance (Erev 0 mV) and 
- two transient (A-type) K+-conductances with different kinetics and reversal 

potentials (Erev -84 mV and Erev -90 mV). 
 
The equations describing the current kinetics of the first 4 conductances are based on the 
kinetics of these currents in bullfrog sympathetic B neurons (Yamada et al., Methods in 
Neuronal Modeling: From Synapses to Networks, Eds: C. Koch and I. Segev. Cambridge, 
MA: MIT Press, 1989, p. 97–133). Since the inactivation of the delayed-rectifying 
potassium current is slow, we have omitted the inactivation parameter from our model. The 
effects of including inactivation have been described elsewhere (Schobesberger et al., J. 
Neurophysiol. 83:1912-1923 2000). 
The equations describing the current kinetics of the first transient (A-type) K+-conductance 
are based on recordings from rat dopaminergic neurons (Hahn et al., J. Neurosci. 26:10859-
10866 2003) while the current kinetics of the second transient (A-type) K+-conductance are 
also based on those of bullfrog sympathetic B neurons (Yamada et al.). 
 
G-clamp calculates activation and inactivation variables using Euler integration. The 
formulae for exponential Euler integration shown below are purely illustrative. 
 

11.1. Fast inactivating Na+ current 
INa(V, t) = Nag m2(V, t) h(V, t) (V – ENa) 
dm(V, t)/dt = [m∞(V) – m(V, t)] / τm(V)    (activation variable) 
m∞(V) = αm(V) / [αm(V) + βm(V)]     (steady-state) 
τm(V) = 2 / [αm(V) + βm(V)]      (time constant) 
 αm(V) = [0.36 (V + 33)] / [1 – exp{–(V + 33) / 3}]  (forward rate) 
 βm(V) = [–0.4 (V + 42)] / [1 – exp{(V + 42) / 20}]  (backward rate) 
m(V, t+Δt) = m(V, t) + [[m∞(V) – m(V, t)] / τm(V)] Δt   (Euler integration) 
m(V, t+Δt) = m∞(V) + [m(V, t) + m∞(V)] exp{–Δt / τm(V)}  (exponential Euler) 
 
dh(V, t)/dt = [h∞(V) – h(V, t)] / τh(V)     (inactivation variable)  

h∞(V) = αh(V) / [αh(V) + βh(V)] 
τh(V) = 2 / [αh(V) + βh(V)]  
 αh(V) = [–0.1 (V + 55)] / [1 – exp{(V + 55) / 6}] 
 βh(V) = 4.5 / [1 + exp{–V / 10}] 
h(V, t+Δt) = h(V, t) + [[h∞(V) – h(V, t)] / τh(V)] Δt 
h(V, t+Δt) = h∞(V) + [h(V, t) + h∞(V)] exp{–Δt / τh(V)} 
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11.2. Delayed-rectifierK+ current 
IK(V, t) = Kg n2(V, t) (V – EK) 
dn(V, t)/dt = [n∞(V) – n(V, t)] / τn(V)     (activation variable)  
n∞(V – 20) = αn(V – 20) / [αn(V – 20) + βn(V – 20)] 
τn(V) = 1 / [αn(V) + βn(V)] 
 αn(V) = [0.0047 (V + 12)] / [1 – exp{–(V + 12) / 12}] 
 βn(V) = exp{–(V + 147) / 30} 
n(V, t+Δt) = n(V, t) + [[n∞(V) – n(V, t)] / τn(V)] Δt 
n(V, t+Δt) = n∞(V) + [n(V, t) + n∞(V)] exp{–Δt / τn(V)} 
 

11.3. M-type K+ current 
IM(V, t) = Mg w(V, t) (V – EM) 
dw(V, t)/dt = [w∞(V) – w(V, t)] / τw(V)    (activation variable) 
 w∞(V) = 1 / [1 + exp{–(V + 35) / 10}] 
 τw(V) = 1000 / [3.3 [exp{(V + 35) / 40} + exp{–(V + 35) / 20}]] 
w(V, t+Δt) = w(V, t) + [[w∞(V) – w(V, t)] / τw(V)] Δt 
w(V, t+Δt) = w∞(V) + [w(V, t) + w∞(V)] exp{–Δt / τw(V)} 
 

11.4. Leak conductance 
Ileak(V) = gleak (V – Eleak) 
 

11.5. Transient (A-type) K+ current – DA neurons 
IA(V, t) = Ag m3(V, t) h(V, t) (V – EK) 
dm(V, t)/dt = [m∞(V) – m(V, t)] / τm(V)    (activation variable) 
m∞(V) = 1 / [1 + exp{–(V + 24.8) / 13.9}]    (steady-state) 
τm(V) = 2 – (1.6 / [1 + exp{–(V + 20) / 15}])    (time constant) 
m(V, t+Δt) = m(V, t) + [[m∞(V) – m(V, t)] / τm(V)] Δt   (Euler integration) 
m(V, t+Δt) = m∞(V) + [m(V, t) + m∞(V)] exp{–Δt / τm(V)}  (exponential Euler) 
 
dh(V, t)/dt = [h∞(V) – h(V, t)] / τh(V)     (inactivation variable)  

h∞(V) = 1 / [1 + exp{(V + 78.7) / 9.2}] 
τh(V) = 28 – (9.4 / [1 + exp{–(V – 2) / 16}]) 
h(V, t+Δt) = h(V, t) + [[h∞(V) – h(V, t)] / τh(V)] Δt 
h(V, t+Δt) = h∞(V) + [h(V, t) + h∞(V)] exp{–Δt / τh(V)} 
 

11.6. Transient (A-type) K+ current – Bullfrog sympathetic 
neurons 

IA(V, t) = Ag m(V, t) h(V, t) (V – EK) 
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dm(V, t)/dt = [m∞(V) – m(V, t)] / τm(V)    (activation variable) 
m∞(V) = 1 / [1 + exp{–(V + 42) / 13}]    (steady-state) 
τm(V) = 1.38        (time constant) 
m(V, t+Δt) = m(V, t) + [[m∞(V) – m(V, t)] / τm(V)] Δt   (Euler integration) 
m(V, t+Δt) = m∞(V) + [m(V, t) + m∞(V)] exp{–Δt / τm(V)}  (exponential Euler) 
 
dh(V, t)/dt = [h∞(V) – h(V, t)] / τh(V)     (inactivation variable)  

h∞(V) = 1 / [1 + exp{(V + 110) / 18}] 
τh(V) = 150 for V < -80 mV 
  50 for V >= -80 mV 
h(V, t+Δt) = h(V, t) + [[h∞(V) – h(V, t)] / τh(V)] Δt 
h(V, t+Δt) = h∞(V) + [h(V, t) + h∞(V)] exp{–Δt / τh(V)} 
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12. Offline Utilities 
These are LabVIEW VIs written for offline analysis of G-clamp data files. Files with 
analysis results created by these VIs are written to the same directory which contained the 
G-clamp data files analyzed. 
 

12.1. G-clamp FileUtilities Master.vi 
This VI serves as the gateway to the analysis VIs proper. It is used to select G-clamp data 
files and to feed these files into the selected file utility. 
 

 
 
A file dialog opens at VI start (or with Change Directory) to navigate to a directory 
containing G-clamp data files (Press Current Folder to exit the file dialog window). All 
files (and subfolders) are listed in alphanumerical order. File types can be used to limit the 
file list to display only files of the selected type. 
File Utilities is populated at VI start with the analysis VIs available and used to select an 
analysis VI. Analysis VIs typically are specific for one of the G-clamp data file types and 
the data files that can be processed by the selected analysis VI are shown in the file list on a 
gray background. 
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All files selected in the file list will be processed successively by the analysis VI selected 
when Do it! is pressed. Once the analysis VI finishes a new data directory/file/analysis VI 
selection can be made to process another set of data files. 
Done stops G-clamp FileUtilities Master.vi. 
 
 

12.2. G-clamp Count APs in GAI-file.vi 
This VI uses a peak detection function to find action potentials in files created by the 
Synaptic Gain module (or by the Strip Chart module after the stp-files have been converted 
to gai-files). 
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Analyze toggles the VI from working either on the voltage trace (current clamp recording) 
or the current trace (e.g. loose patch voltage clamp recording). Accordingly, peaks/valleys 
toggles the function from detecting AP peaks or inward current peaks. Peaks have to be 
above threshold (mV) while valleys have to be below. Peak detection is based on an 
algorithm that fits a quadratic polynomial to sequential groups of data points. The number 
of data points used in the fit is specified by width (datapoints)16. Each peak/valley found 
is marked in the waveform graph by a red square. An initial part of the trace can be 
excluded from the peak search with Settling time (s). If Settling time (s) > 0 then this 
initial part of the trace is used to calculate mean Vm/Ih (mV/pA) otherwise mean Vm/Ih 
(mV/pA) yields NaN (Not a Number). Analysis of the whole trace occurs in consecutive 
segments. The length of these segments can be adjusted with segment length (s) while # of 
segments informs the user about the total number of segments for a specific segment 
length. Next proceeds to the next segment while Previous goes back to the segment before 
the current one. Any change in Analyze, peaks/valleys, threshold (mV), width 
(datapoints) or Settling time (s) triggers re-analysis of the current trace. A change in 
segment length (s) triggers re-analysis of the trace from its beginning. 

                                                 
16 width (datapoints) is coerced to a value greater than or equal to 3. The value should be no more than about 
1/2 of the half-width of the peaks/valleys and can be much smaller (but > 2) for noise-free data. Large widths 
can reduce the apparent amplitude of peaks and shift the apparent location. For noisy data, this modification 
is unimportant since the noise obscures the actual peak. Ideally, width should be as small as possible but 
must be balanced against the possibility of false peak detection due to noise. 
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The output of this VI consists of indicators on the front panel (mean Vm/Ih (mV/pA), APs 
in current segment, Total # of APs) and two ASCII text files (GAI – Vm APs per 
segment.txt and GAI – Individual APs.txt). GAI – Individual APs.txt contains three 
columns of data: The 1st column contains the locations (time relative to start of recording 
minus Baseline Duration (sec)) of all peaks or valleys detected. The 2nd column contains 
the interspike intervals and the 3rd column contains the peak amplitudes. A new set of three 
columns is added for each gai-file processed. GAI – Vm APs per segment.txt contains 
one column of data for each gai-file processed. The 1st value corresponds to mean Vm/Ih 
(mV/pA), the 2nd value to Settling Time (s), the 3rd value to segment length (s), the 4th 
value to # of segments and the remaining values to the number of peaks/valleys found in 
each segment. 
 
 

12.3. G-clamp Retrieve GTH-file Results.vi 
This VI retrieves the threshold-gsyn value from a gth-file together with some other useful 
information. 
 

 
 
The VI displays and works only on the voltage traces of a gth-file. Part of each trace can be 
defined as baseline with Baseline Start (sec) and Baseline Duration (sec). A mean value 
is derived from all data points in the baseline part of the voltage traces and from the mean 
values of all voltage traces in a gth-file a final mean value and standard deviation is 
calculated. The VI also determines a mean action potential peak value by averaging the 
peak values of all action potentials found. AP Search Start can be used to exclude 
conditioning action potentials prior to the test synapse. Action potentials are found using 
the same algorithm and parameters (threshold (mV), width (datapoints)) as described in 
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section 11.2. for G-clamp Count APs in GAI-file.vi. All parameters can be changed until 
Set is pressed which initiates processing of the current file. 
The output of this VI consists of an ASCII text file (GTH Results.txt) which contains one 
line of tab-delimited data for each gth-file processed. The columns in this file contain: 
1st column: time of recording (hh:mm:ss; this time format is MS Excel compatible, 

allowing plotting of results vs. time) 
2nd column: mean membrane potential during baseline period (mV) 
3rd column: SD of membrane potential during baseline period (mV) 
4th column: threshold-gsyn (nS) 
5th column: mean action potential peak (mV) 
 
 

12.4. G-clamp Get Membrane Test Results.vi 
This VI is an off-line version of the Membrane Test function available in G-clamp. The 
latter is more geared towards a speedy analysis by averaging only a limited number of 
current responses and by using a simple least square fit to determine the time constant of 
the averaged current response. G-clamp Get Membrane Test Results.vi on the other hand 
averages as many current responses as supplied with, i.e. as many as are contained in an 
ivb-data file and it uses the Levenberg-Marquardt algorithm to determine the least squares 
set of coefficients in an iterative process. 
For details on the calculations see section 7. Membrane Test and 7.1. Calculations. 
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To perform the exponential fit to the decay phase of the current transient the function has to 
be provided with a) information about the voltage pulse used and b) initial guess 
coefficients for the fit. 
 
The voltage pulse has to be defined with Baseline Duration, Pulse Duration and Pulse 
Amplitude. 
 
Initial Guess Coefficients Fit contains three numerical values. The first value corresponds 
to the initial amplitude of the signal, the second value corresponds to the inverse of the time 
constant of decay and the third value corresponds to the end value ultimately approached 
by the exponential. 
 
All user-settable parameters can be changed any time. Each change triggers a re-calculation 
of the outputs. 
 
With Done the VI proceeds to the next data file or stops after processing the last data file. 
This VI does not save processing results to file; therefore its output (Ra, Rm, Cm, τm and 
Ih) has to be written down by the user before proceeding to the next file. 
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12.5. G-clamp Convert stp-to-gai.vi 
Converts stp-files created by the Strip Chart module into gai-files. The original stp-files 
remain in the folder. 
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13. Data files 
 

13.1. Names 

Data file names have the general form ddhhmmss.??? in which 

- dd is the day of month, 

- hh is the hour (24-hour clock), 

- mm is the minute, 

- ss is the second when the experiment finished, and 

- ??? indicates the experiment type (Vclamp: IVB; Gsyn Threshold: GTH; Synaptic 

Gain: GAI ) 

All numerical values in the name have a leading zero if in the single-digit range. 

 

13.2. Content 

Each G-clamp experiment module has its own data file format. 

 

12.2.1 Vclamp - *.IVB 

- a SGL giving the number of iterations done 

- 4 SGLs without meaning 

- a SGL giving the episode duration in ms 

- a SGL giving the sample rate in Hz 

- a SGL giving the pause time (in ms) between epsiodes 

- as often as episodes were performed: 

- a 1-D array of SGLs giving the voltage trace 

- a 1-D array of SGLs giving the current trace 
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12.2.2 Gsyn Threshold - *.GTH 

- a SGL giving the length of the following string 

- a string giving the name of the event file used for the experiment 

- a SGL giving the number of episodes 

- 2 SGLs giving the initial upper limit (in nS) for the search algorithm 

- a SGL giving the pause time (in ms) from end of one episode to start of next 

- a SGL giving the reversal potential Erev of the virtual synapse 

- a SGL giving the sample rate (Hz) 

- as often as episodes were performed: 

- a SGL giving the strength of the virtual synapse in nS 

- a 1-D array of SGLs giving the voltage trace 

- a 1-D array of SGLs giving the current trace 

 

12.2.3 Synaptic Gain - *.GAI 

- a SGL giving the length of the following string 

- a string listing the template file(s) used for the experiment 

- a SGL giving 1/sample rate (sample rate is in Hz) 

- a SGL without any meaning 

- a SGL giving the number of action potentials elicited 

- a SGL giving the length of the traces as # of data points 

- a number of bytes (0s) to extend header length to a total of 512 bytes 

- voltage trace (SGLs) 

- current trace (SGLs) 

 

12.2.4 Strip Chart - *.STP 

- a DBL of value 1 

- a DBL giving the number of data channels (2) 

- as many DBLs as indicated by the previous DBL, each giving the sample rate 
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- as often as 1-sec episodes were recorded: 

- for each data channel a 1-D array of SGLs comprising a 1-sec episode 

Use “Convert stp-to-gai.vi” in “G-clamp.lvproj\My Computer\OfflineUtilities” to convert 

stp-files to gai-files. 
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Appendix A – G-clamp Installation 
 

Hardware 
 

Connecting embedded controller and host computer 
Connect both machines directly using a cross-over cable17. 
 
DO NOT go through a local area network (LAN)! We found that when going through a 
LAN transfer of larger amounts of data (>~100.000 bits) is not reliable, causing the host 
computer part of the G-clamp software to wait forever for a wrong amount of data from the 
controller and therefore to become unresponsive. 
Even if the reason for this bug could be figured out, we recommend the direct connection: 
Because there is no other network traffic, the direct connection is so fast that even tens of 
Megabytes of data (several minutes of experiment with the Synaptic Gain Module) can 
now be transferred to the host computer in almost no time for display and saving. 
 

Connecting recording amplifier and break-out box (BNC-2090) 

AxoClamp 2B 
- OUTPUT 10 Vm  analog-in 0 
- OUTPUT Im  analog-in 1 
- INPUT EXT. ME1 COMMAND  analog-out 0 
- INPUT EXT. VC COMMAND  analog-out 1 

Model 2400 
- (variable) Output  analog-in 8 
- Fixed Output x 10 Vm  analog-in 9 
- Fixed Output Im  analog-in 10 
- Telegraph Output FREQ  analog-in 12 
- Telegraph Output MODE  analog-in 13 
- Telegraph Output GAIN  analog-in 14 
- Telegraph Output Cmembrane  analog-in 15 
- EXTERNAL (command input)  analog-out 0 
 
- analog-out 1 can be used to trigger/gate an external device 

                                                 
17 Alternatively – according to NI – you can also use normal network cables with a hub between embedded 
controller and host computer. We did not test this alternative and can not exclude the possibility that this 
solution might have the same problems as experienced when going through a LAN. 
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MultiClamp 700B 
- Primary Output  analog-in 0 
- Secondary Output  analog-in 1 
- Command Input  analog-out 0 

 
- analog-out 1 can be used to trigger/gate an external device 

 

Software 
- Extract the content of the file G-clamp.zip on your drive C:\. This will result in a 

folder C:\G-clamp with several subfolders. 
- LabVIEW-RT 8.0 does not work with the built-in firewall of Windows XP, i.e. the 

Windows firewall has to be disabled.18 
- Start Measurement & Automation Explorer (MAX) and start the Configuration 

Import Wizard under File > Import… Import one of the files G-clamp v2_1.ini, G-
clamp v2_1.txt or G-clamp v2_1.nce19 (from C:\G-clamp\Main VIs\Target) to 
your embedded controller. These files contain all the NI-DAQmx Scales, Global 
Virtual Channels and Tasks defined for the AxoClamp 2B, Model 2400 and 
MultiClamp 700B recording amplifiers. (Under Devices and Interfaces complete 
the sections NI-DAQmx Devices and PXI Systems according to your hardware) 

- Start LabVIEW 
o LabVIEW 8.0: Open the LabVIEW project G-clamp.lvproj from C:\G-

clamp\. 
o LabVIEW 8.2: Open a new, empty VI and select Tools > Advanced > Mass 

compile… Select the folder C:\G-clamp\ and enable Log Results in the 
Mass Compile Dialog as a tool to track compile errors. If you have also 
LabVIEW 8.0 installed, temporarily rename the LabVIEW 8.0 directory to 
force LabVIEW to search for newer VI versions in the LabVIEW 8.2 
directory. You might be asked to search for certain VIs because LabVIEW 
can not find them. They should all be somewhere in the LabVIEW 8.2 
directory. Skipping the search for files that LabVIEW can not find will 
result in their calling VIs being non-executable. Next open the LabVIEW 
project G-clamp.lvproj from C:\G-clamp\. 

- In the project right-click Project: G-clamp.lvproj and select New > Targets and 
Devices… Search for and add your embedded controller to the project. 

- Right-click your embedded controller and select Properties… Under VI Server: 
Configuration check the box TCP/IP to enable this protocol.20 

- Next create a source distribution (in C:\ni-rt\startup on the host computer) of all 
files required to run the master program on the embedded computer (G-clamp v2 – 
Target.vi). 

                                                 
18 A firewall that works with LabVIEW-RT 8.0 is the free, basic version of ZoneAlarm. Add the IP address of 
the embedded controller to the list of trusted zones. 
19 Importing the …nce file has been found to be problematic sometimes, while on the same set-up import of 
the …ini or …txt file occurred without errors. 
20 It is not necessary to add the host computer to the VI Server machine access list. By default, machine 
access should be unrestricted with the wildcard symbol “*”. 
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o LabVIEW 8.0: Under My Computer > Build Specifications select Main 
Target VI; right-click and select Build. 

o LabVIEW 8.2: Because the Build Specifications dialog has been changed 
to include more options the Main Target VI specification under My 
Computer > Build Specifications needs to be partially re-done. 
Specifically, the Distribution Settings have to be specified such that the 
build process limits the files in the distribution to only those files required. 
This is done by disconnecting type definitions and by removing unused 
polymorphic VI instances. Do not exclude vi.lib, instr.lib and user.lib. As a 
result of the build process you should end up with about 40 to 50 files in 
C:\ni-rt\startup. If you start accumulating many more files than that or if the 
build process takes more than 5 minutes you have not selected the most 
efficient distribution settings. Cancel the process and try another setting. 
While the additional files won’t do any harm, they will prolong the build 
process and it will take hours to copy all these files on the embedded 
computer as the FTP protocol used between host computer and controller 
performs a directory check after each file copy which will take longer and 
longer the more files are already in the target directory. 

o LabVIEW 8.5 (see comments above to LabVIEW 8.2): In Additional 
Exclusions check Disconnect type defs, Remove unused polymorphic VI 
instances and Remove unused members of project libraries before 
executing Build. 

- Next create a source distribution (in C:\ni-rt\startup\Dynamic VIs on the host 
computer) of all files required to run the experiment modules from within the 
master program on the embedded computer. 

o LabVIEW 8.0: Under My Computer > Build Specifications select Target 
Dynamic VIs; right-click and select Build. 

o LabVIEW 8.2: Apply the LabVIEW 8.2-specific comments above for the 
build process of My Computer > Build Specifications > Target Dynamic 
VIs. You should end up with about 150 files in C:\ni-rt\startup\Dynamic 
VIs. 

- Copy the folder C:\ni-rt\ with all its sub-directories and files from the host 
computer into the root directory C:\ of the embedded controller. 

- In the project under My Computer\Host\G-clamp v2 – Host.lvlib\ open the file G-
clamp v2 Host.cfg. 

o In the section [LastUsed] replace the Target entry with the name of your 
embedded controller. 

o In the section [Available] replace the existing Targets entries with the name 
of your embedded controller. 

o Edit one of the existing target sections ([G-clamp1] or [G-clamp2]; delete 
the other one) so that the section has the name of your embedded controller 
and the IP entry has its IP address. 

- For MultiClamp 700B Users only: If your MultiClamp Commander software is 
NOT installed under C:\Axon\MultiClamp 700B Commander create the directory 
C:\Axon\MultiClamp 700B Commander\3rd Party Support\AxMultiClampMsg and 
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copy the files contained in C:\G-clamp\Amplifiers\MultiClamp 700B Files into this 
folder. 

 

Trouble-Shooting 
This section gives hints on how to deal with problems we encountered. Disclaimer: 
Because we do not completely understand the reason for these problems we do not claim 
that our solutions will always work or that they are the only possible and/or best solutions. 
 

- The embedded controller is seen by MAX but LabVIEW or Internet Explorer/MS 
Explorer (FTP clients) are unable to connect to the embedded controller. 

o Make sure that embedded controller and host computer are on the same 
subnet. If the problem persists try different subnet masks. E.g. on one of our 
set-ups subnet mask 255.255.255.0 for embedded controller and host 
worked fine while on another we had to change the mask to 255.255.0.0 to 
make it work. 

- G-clamp starts fine, updating RT Target System Info or amplifier settings (if the 
Model 2400 amplifier module is in use) works, but when an experiment is started 
no commands are given to the amplifier and no data are recorded. 

o This seems to be a problem with the deployment of the network-shared 
variables from the host computer to the embedded controller when the host 
computer is running under an IP address different from the one that was 
used when the shared variables were created during G-clamp development. 
Possible work-arounds: 

 In the project right-click the embedded controller and select 
Connect. This apparently deploys the missing stuff to the embedded 
controller. After the deployment you can safely disconnect. 

 With host computer and embedded controller connected directly via 
a cross-over cable, change the IP address of the host computer to 
136.142.127.88. If you disconnect from the embedded controller and 
connect to your LAN you have to change back to your network 
administrator-assigned IP address.21 

 Re-link every instance of a network-shared variable in all VIs to the 
networks-shared variables in the project: Open each VI, right-click 
every instance of a network-shared variable, select Select variable… 
and OK the right variable. Finally, create the source distributions 
Main Target VI and Target Dynamic VIs again and copy the created 
files again to the embedded controller (see above). 

 Replace all network-shared variables with newly created ones (huge 
PITA): Carefully write down for each network-shared variable under 
My Computer\Host its properties (location in the project, name, data 
type…), delete them and create them new. Next re-link every 
instance of a network-shared variable in all VIs in the project to the 

                                                 
21 If your Internet Protocol (TCP/IP) settings are configured to obtain an IP address automatically, you can 
use Alternate Configuration to assign a User configured IP address (i.e. 136.142.127.88) whenever the host 
computer is connected to the embedded controller and therefore not connected to the LAN. 
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newly created variables. Finally, create the source distributions Main 
Target VI and Target Dynamic VIs again and copy the created files 
again to the embedded controller (see above). 

- After a LabVIEW/G-clamp crash on the host computer G-clamp is not able any 
more to connect to the embedded controller. 

o Sometimes crashes result in changes to the file c:\ni-rt.ini on the embedded 
controller, e.g. in deletion of the line server.tcp.enabled=True. It is therefore 
useful to have a working copy of ni-rt.ini on the host computer to replace a 
damaged version on the embedded controller. 

- All experiment modules and any of the tests (Seal, Membrane, Bridge) returns only 
a line of zero value to the host computer although the time axis of the waveform 
graphs in each module/test are set to the specified value. 

o Check the values of the two post-amplifier amplification controls (Gain V 
and Gain I) on the General page of the user interface. For unknown reasons 
looking up or changing properties of these controls can result in reverting of 
the default value back to the LabVIEW default value 0. If this happened, 
any data point acquired will be multiplied with 0. To change the default 
value see Appendix B – Setting the default Gain values. 
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Appendix B – Customizing G-clamp 
 

Gain V and Gain I controls 
 

 
 
These controls specify the amplification factors if an additional amplification stage after 
the recording amplifier is used to better utilize the full range of the analog-to-digital 
converters of the data acquisition board. (If this stage is not present, both controls should be 
set to 1) 
 
These controls can be customized 

- to reflect the possible settings of your specific amplifiers, and 
- to change the default setting to the value used most of the time. 

For both customizations G-clamp v2 – Host.vi has to be in a non-running (stopped) state. 

Customizing Gain values 
- Right-click the control and select Properties. 
- In the Knob Properties dialog 

go to the page Scale and set the 
Minimum and Maximum values 
of Scale Range to your specific 
values. 
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- Next go to the page Text Labels.22 
- Activate Use text labels for scale markers. 
- De-activate Sequential values. 
- Enter the text labels and corresponding values for your specific amplifier by editing 

the existing entries and/or deleting entries and/or inserting new entries. 
 

 
 

- After exiting the Knob Properties dialog save G-
clamp v2 – Host.vi. 

 
 
 
 
 
 
 
                                                 
22  (In LabVIEW 8.0 this page does not correctly reflect the current settings of the control. Thus when looking 
at this page without making any changes to other control properties use Cancel to exit this dialog. If changes 
to another control property require exiting the dialog with OK, some settings on this page have to be re-
specified as described in the text.) 
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Setting the default Gain values 
- Move the needle to the value you want as default setting. 
- Right-click the control and select Data Operations > Make Current Value 

Default. 
- Save G-clamp v2 – Host.vi. 
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